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1. 개발환경 개요

전자정부 개발프레임워크 이해관계자 주요 관심사 분석전자정부 개발프레임워크 이해관계자 주요 관심사 분석

응용 SW 개발자 응용 SW

개발프레임워크 관리자 운영 SW 운영자

개발

전자정부

표준프레임워크

실행

관리 운영

• 응용 SW 개발자는 전자
정부 개발프레임워크를
기반으로 어플리케이션을
개발하며, 개발 생산성 향
상을 위해 전자정부 개발
프레임워크로부터의 개발
지원 기능이 필요함

• 개발프레임워크 관리자는
전자정부 개발프레임워크
의 지속적인 개선 및 유지
보수를 담당하며, 전자정
부 개발프레임워크의 효
과적인 관리 지원 기능이
필요함

• 응용 SW는 전자정부 개발
프레임워크를 기반으로 개
발되는 어플리케이션으로써
어플리케이션의 효과적인
동작을 위한 전자정부 개발
프레임워크의 실행 지원 기
능이 필요함

• 응용 SW 운영자는 응용
소프트웨어의 운영과정에
서 어플리케이션의 기반
인 전자정부 개발프레임
워크로부터의 운영 지원
기능이 필요함

개발 환경은 프레임워크 이해관계자 중 응용 S/W 개발자를 위한 환경

1.개발환경 개요
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2. 서비스 도출 (1/2)

개발 환경 서비스 그룹 사례 분석개발 환경 서비스 그룹 사례 분석

개발프레임워크 기술구조 사례 연구

개발프레임워크
(사업자 명)

요구분석자
지원 서비스

분석 설계자
지원 서비스

*

구현자
지원 서비스

테스터
지원 서비스

배포자
지원 서비스

형상/변경관리
자 지원 서비

스

프로젝트관리
자

지원 서비스

SYSTEMiER
(삼성 SDS)

N/A N/A
Code/Conf. Generation,

Debugging

Test Automation,

Test Reporting
Deployment 형상관리 N/A

Nexcore
(SK C&C)

N/A 모델링
IDE, 템플릿 및 개발 표준,

코드 Inspection

단위 테스트, 성

능 테스트
자동 빌드 형상관리 N/A

DevOn
(LG CNS)

N/A
모델링,

MDSD

개발환경 설치, IDE,

Prototype, 코드

Inspection

단위 테스트, 성

능 테스트
자동 빌드 형상관리 N/A

Live Framework
(현대정보기술)

N/A N/A Debugging Testing Deployment Version Control N/A

한화 프레임워크
(한화 S&C)

N/S N/A N/A N/A 빌드
소스형상관리,

버그 추적관리
N/A

ProFrame
(TmaxSoft)

N/A

RSD/RSA

Transformatio

n

디버깅, EMB Designer,

ProMapper, DBIO Editor
Service Tester

Deploy

Management

버전 관리, 개발

자 권한 관리
N/A

응용 SW 개발자의 역할인 요구 분석자, 분석 설계자, 구현자, 테스터, 배포자, 형상 및 변경 관리자,

프로젝트 관리자 등을 지원하는 사례 분석 결과는 다음과 같음

1.개발환경 개요
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2. 서비스 도출 (2/2)

개발 환경 서비스 그룹 도출개발 환경 서비스 그룹 도출

서비스 그룹 설명

Implementation
Tool

• 업무 프로그램 구현을 지원하는 도구임

Test Tool
• 구현된 업무 프로그램의 테스트를 지원하는 도구
임

Deployment
Tool

• 구현 완료된 업무 프로그램을 실행 환경에 배포
가능한 형태로 패키징하고, 패키징된 업무 프로그
램을 실행 환경에 배포하는 도구임

Configuration &
Change

Management
Tool

• 형상 및 변경 관리 지원 도구임

개발 환경

Im
p
le
m
e
n
ta
tio
n
T
o
o
l

T
e
st
T
o
o
l

D
e
p
lo
y
m
e
n
t
T
o
o
l

C
o
n
fig
u
ra
tio
n
&
C
h
a
n
g
e

M
a
n
a
g
e
m
e
n
t
T
o
o
l

환경 서비스그룹

전자정부 개발프레임워크 개발 환경의 서비스 그룹은 Implementation Tool, Test Tool,

Deployment Tool, 그리고 Configuration & Change Management Tool로 구성됨

1.개발환경 개요
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3. 개발환경 구성요소

Coding Build Commit

Debugging

• Compile
• Test
• Packaging
• Inspection

CheckOut Build

DeployWAS 재기동

정상
여부

예

아니오

• Compile
• Test
• Packaging
• Inspection

개발자 PC 개발 서버

운영서버

개발환경은 개발자 PC에서 개발서버, 운영서버로 연결되는 개발 흐름을 지원함

형상관리

• Source
• TestCase

1.개발환경 개요

Implementation Tool

Debug

Editor

Methodology &
Template

Test Tool

Test Reporting

Unit Test

Deployment Tool

Build

Deployment

Conf. & Change Mgt.

Tool
Configuration Mgt.

Change
Management

Code Generation

Code Inspection

Batch Batch Test
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4. 개발환경 선정 오픈소스(1/2)

개발환경 오픈소스 SW 선정결과개발환경 오픈소스 SW 선정결과

개발환경 오픈소스 SW 1,2차 평가를 통해 선정된 22개의 오픈소스 SW는 다음과 같음

1.개발환경 개요

No 서비스 그룹 서비스 오픈소스 라이선스

1

구현도구

Editor

Source Editor Eclipse EPL & EDL

2 UML Editor AmaterasUML EPL 1.0

3 ERD Editor AmaterasERD EPL 1.0

4 Web Flow Spring Web Flow N/A

5 Code Inspection PMD, FindBugs BSD, LGPL

6
New Batch Template

Project
Spring Batch Apache License 2.0

7 New Batch Job Spring Batch Apache License 2.0

8 New Batch Job Launcher Spring Batch Apache License 2.0

9
Debug

Local Debug Eclipse EPL & EDL

10 Remote Debug Eclipse EPL & EDL
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4. 개발환경 선정 오픈소스(2/2)

개발환경 오픈소스 SW 1,2차 평가를 통해 선정된 22개의 오픈소스 SW는 다음과 같음

1.개발환경 개요

No 서비스 그룹 서비스 오픈소스 라이선스

11

테스트도구

Unit Test

TestCase Junit CPL

12 Mock Support EasyMock MIT

13 DB Support DbUnit LGPL 2.1

14 Test Automation Ant, Maven Apache License 2.0

15 Test Reporting Ant, Maven Apache License 2.0

16 Test Coverage EMMA CPL

17 Batch Job Test Spring Batch Apache License 2.0

18

배포도구 Build

Build Tool Maven Apache License 2.0

19 CI Server Hudson/Jenkins
Creative Commons Attribution

Share-Alike License,MIT

20 Nexus Nexus GPL

21
형상관리도구

Configuration Management Subversion Subversion License

22 Change Management jTrac Apache License 2.0

개발환경 오픈소스 SW 선정결과개발환경 오픈소스 SW 선정결과
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5. 서비스 별 소개 - 구현도구

구성요소 설명

에디터

• SourceCode Editor로 편리한 소스 코드 작성 환경 제공
• UML, ERD 에디터 제공
• DBIO 에디터를 통해 SQL작성 및 수행결과 확인 가능
• WebFlow Editor를 통해 설정 파일의 유효성 검사 및 Edit

디버거
• 편집모드와 디버깅 모드의 전환을 통한 작업의 편의성 향상
• Remote 디버깅 제공

방법론(개발절차) • 애플리케이션을 개발 가이드 제공

템플릿 프로젝트 • 애플리케이션 개발 시 자동으로 템플릿을 생성 마법사 제공

공통 컴포넌트 • 애플리케이션 개발 시 마법사를 통해 공통컴포넌트를 추가 기능 제공

맞춤형 개발환경 • 프로젝트에서 필요로 하는 기능만을 선택적으로 구성할 수 있는 도구 제공

배치 템플릿 프로젝트
• New eGovFrame Batch Template Project 생성 마법사 실행
• 배치 처리 구성 별 예제 제공

배치 Job 생성
• 배치 작업 파일 생성 마법사 실행
• 배치 Job / Step / Item 설정으로 XML 파일 생성

배치 Job Launcher
• 배치 작업 실행 파일 생성 마법사 실행
• 배치 처리 구성 시 최초에 필요한 Launcher, Repository의 설정 XML 파일 생성

구성요소 별 상세구성요소 별 상세

개발자의 코드 작성 및 디버깅을 지원하는 도구로 Eclipse 기반 하에 추가 Plug-in을 제공

1.개발환경 개요
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5. 서비스 별 소개 – 테스트 도구

테스트도구구현도구

테스트 대상 모듈

결과 리포트Coverage 리포트

테스트
기반 환경

Test
Reporting

Coverage
분석

테스트 클래스

작성

실행

분석작성

구성요소 설명

테스트
기반환경

• Junit 기반의 Unit Test 작성 지원
• Mock 및 DB Support

Test
Reporting

• Eclipse 기반의 Green Bar GUI
• HTML/XML/Excel 형식의
Reporting 지원

Coverage
분석

• TestCase가 커버하는 정도를 수치
및 코드 영역을 통해 확인

Batch Job
Test

• 배치 관련 파일을 활용하여 간단
히 테스트할 수 있는 테스트 마법
사 실행

구성요소별 상세구성요소별 상세

개발자가 자신의 코드를 테스트하기 위해 JUnit 기반으로 TestCase의 작성 및 수행을 지원하고, 자

동으로 테스트하고 리포팅하도록 지원하는 도구

1.개발환경 개요

주요 메커니즘주요 메커니즘
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5. 서비스 별 소개 – 배포 도구

구현도구
배포도구 프로젝트 팀

테스트도구

형상관리도구

저장소

배포정책

PM, QM 등

개발자

빌드자동화도구 빌드도구

리포트

서버

결과 알림

정책 적용

결과 확인

구성요소 설명

빌드 도구

• Maven 기반의 빌드 수행
• 3rd Party 라이브러리 관리 편의성
을 위한 Nexus Repository 제공

빌드 자동화
도구

• 형상관리도구와 연계하여 소스가
변경된 경우에만 빌드를 수행

• 배포 정책에 따라 설정된 주기에
자동 수행

• 빌드 결과에 대한 리포트 및 피드
백 기능 제공

• 서버 이관 및 WAS 기동/중지

구성요소별 상세구성요소별 상세

Maven 기반의 개발자 빌드와 CI서버를 통한 지속적인 통합을 지향

1.개발환경 개요

주요 메커니즘주요 메커니즘
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5. 서비스 별 소개 – 형상관리

프로젝트팀 형상관리 배포 도구

저장소

빌드자동화도구

개발자

PL

CMO

Configuration
Management

이슈 관리

Check
in/out

Change
Management

배포

백업

백업

구성요소 설명

Config.
Mgmt

• Subversion을 그대로 활용
• 이슈ID 등록을 통한 이슈 연계

Change
Mgmt

• JAVA기반의 이슈관리 시스템
• 이슈 등록, 검색, 처리 기능 제공

구성요소별상세구성요소별상세

형상요소의식별, 이력관리를지원하는형상도구와 JAVA기반의이슈관리시스템제공

1.개발환경 개요

주요 메커니즘주요 메커니즘
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설치

– eGovFrame-3.10.0.exe파일을 C:\드라이브에서실행한다.

6. 개발자 개발환경 구성 (1/9)

디렉토리정보

디렉토리 설명

bin 실행파일

android-sdk-windows 윈도우용안드로이드 SDK폴더

apache-tomcat-8.5.50 Apache Tomcat

eclipse 개발환경이포함된 Eclipse IDE for Java EE

Developers 2020-06 (4.16.0)

jdk8u242-b08 OpenJDK - hotspot VM(JDK_HOME)

mysql-5.6.21 실습용 DB

mysql-5.7.32-winx64 실습용 DB (64bit)

maven/repository Local Maven Repository

textbook 교육교재파일 (PDF)

workspace.edu Eclipse Workspace

1.개발환경 개요
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실행

– “C:\eGovFrame-3.10.0\eclipse”를더블클릭하여 Eclipse를실행한다.

1.개발환경 개요6. 개발자 개발환경 구성 (2/9)
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설정

– Maven Installations설정확인

6. 개발자 개발환경 구성 (3/9) 1.개발환경 개요
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설정

– Apache Tomcat 설정

6. 개발자 개발환경 구성 (4/9) 1.개발환경 개요
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설정

– 대상프로젝트 DB구동을확인한다. ( example project name: lab102-code-generation)

– C:\egovFrame-3.10.0\workspace.edu\lab102-code-generation\DATABASE\db\runHsqlDB.cmd”를더블클

릭하여 Sample용 DB를띄운다.

6. 개발자 개발환경 구성 (5/9) 1.개발환경 개요
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설정

– Eclipse의 “Data Source Explorer” View에서 “SampleHSQLDB”에서오른쪽버튼의 “connect”를선택하

여다음과같이테이블이설정되어있는지확인한다.

6. 개발자 개발환경 구성 (6/9) 1.개발환경 개요
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설정

– Eclipse에서 “Build Automatically”가선택되어있다.

6. 개발자 개발환경 구성 (7/9) 1.개발환경 개요
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설정

– 프로젝트앞에빨간아이콘이있어오류가있다면 Maven → Update Project 을실행해본다.

6. 개발자 개발환경 구성 (8/9) 1.개발환경 개요
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개발자개발환경선택적구성

– 개발환경구성시필요기능만을선택하여개발환경을선택적으로구성하는기능을제공

6. 개발자 개발환경 구성 (9/9) 1.개발환경 개요

제공기능

– eGovFramework AmaterasERD

– eGovFramework AmaterasUML

– eGovFramework Batch IDE

– eGovFramework CodeGen

– eGovFramework CodeGen Templates

– eGovFramework DBIO

– eGovFramework DeviceAPI IDE

– eGovFramework Mobile IDE

– eGovFramework RTE Distribution Tool

– eGovFramework TestCase Templates

– eGovFramework Web Standard Verification

– Spring IDE Web Flow Extension(optional)
필요한 기능만을
선택 후 설치
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7. 서버 개발환경 구성 1.개발환경 개요

 다운로드

– eGovFrame 포털(http://www.egovframe.go.kr/)에 접속하여 “다운로드 > 개발환경”에서 제공하는 서버용 개

발환경(Windows, Unix계열) 설치파일을 다운로드 한다.
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7. 서버 개발환경 구성 - Windows 1.개발환경 개요

 설치

– eGovCI-3.9.0_XXbit.exe 파일을 실행하여 압축을 해제한다.
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7. 서버 개발환경 구성 - Windows 1.개발환경 개요

 설치

– <eGovCI_home>\bin\VisualSVN-Server-XXX.msi 파일을 실행하여 VisualSVN을 설치한다.
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7. 서버 개발환경 구성 - Windows 1.개발환경 개요

 실행

– Nexus서버구동 : <eGovCI_home>\start-nexus.bat파일을실행하여진행한다.

– Jenkins서버구동 : <eGovCI_home>\start-jenkins.bat파일을실행하여진행한다.

– 브라우저주소입력창에 Nexus서버와 Jenkins서버의 URL을입력하여설치및실행여부를확인할수있다.

[그림 1] Nexus가 실행된 모습 [그림 2] Jenkins이 실행된 모습

http://localhost:8080/jenkins/http://localhost:8081/nexus/
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7. 서버 개발환경 구성 - Linux 1.개발환경 개요

 설치및실행

– 서버개발환경을설치할폴더에 eGovCI-3.9.0.tar.gz파일의압축을해제한다.

– JDK,서버 IP와포트를설정한다.

– 설치완료후정상적으로설치가되었는지확인하고서버를실행한다.

Nexus서버구동 : <eGovCI_home>\start-nexus.sh파일을실행하여진행한다.

Jenkins서버구동 : <eGovCI_home>\start-jenkins.sh파일을실행하여진행한다.

[그림 3] Nexus가 실행된 모습 [그림 4] Jenkins이 실행된 모습

http://localhost:8080/jenkins/http://localhost:8081/nexus/
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1. 개요

2. eGovFrame IDE

3. UML 작성

4. ERD 작성

5. DBIO 작성

6. Code Generation

7. eGovFrame Java Project

8. Common Component

9. Batch Job

10. Batch Job Launcher

11. Batch Configuration

12. eGovFrame Template Project

13. Debug

14. Code Inspection

15. Server Connection Management

16. 참고자료

2.구현 도구
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1. 개요

구현도구는 UML, ERD, Source Code, WebFlow, DBIO Editor와 Template Project, Common

Component, Customize Development Tool,배치 Template및 Job생성그리고 Debug로구성

전자정부 개발프레임워크 구현도구

Eclipse platform

(JEE package)
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1. 개요 - Package 구성

구현도구는 Eclipse Java EE를기반으로 Package와 UML, ERD, DBIO Editor와 Template Project,

Common Component, Customize Development Tool,배치 Template및 Job생성플러그인으로

구성

구현도구가 Eclipse JEE를기반으로하고있으므로

아래와같은패키지가포함되어있다.

- RCP/Platform(Rich Client Platform)

- CVS(Concurrent Versions System)

- EMF(Eclipse Modeling Framework)

- GEF(Graphical Editing Framework)

- JDT(Eclipse Java development tools)

- Mylyn

- WTP (Web Tools Platform )

: Web Tools, Java EE Tools , XML Tools

- RSE(RSE, Target Management )

- Eclipse Link

- PDE(The Plug-in Development Environment)

- Datatools(DTP, Data Tools Platform )

2.구현 도구
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1. 개요 – Eclipse 기본화면구성

Eclipse기본화면은메뉴바,툴바,퍼스펙티브바, 4개의뷰영역으로크게구분된다.이 4개의뷰를포함

하는전체영역을퍼스펙티브(Perspective)라고하고,이 Eclipse Window전체를워크벤치

(Workbench)라부름

2.구현 도구

워크벤치 (Workbench)
메뉴바

툴바

좌측 View 영역

중앙 View 영역

하단 View 영역

우측 View 영역

퍼스펙티브바

Fast 뷰 : 잘 사용하지 않는 화면들을 최소화 시켜놓고 필요한 시점에만 잠깐 활성화 시킬 때 사용된다.

퍼스펙티브
(Perspective)
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구현도구는개발자가개발환경을쉽고편리하게개발할수있도록특성화된통합메뉴, 퍼스펙티브 ,뷰,

에디터등을제공

1. 개요 – 화면 구성 2.구현 도구

eGovFrame 통합메뉴 eGovFrame 퍼스펙티브 전환

DBIO, UML, ERD 등의 다양한 Editor 제공

DBIO Search, Query Result 등의 뷰 기능 제공

OutlineView 등의
활용

Package Explorer,
DataSource Explorer

등의 뷰 제공
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2. eGovFrame IDE (1/4) - eGovFrame Menu

eGovFrame Perspective에서만활성화되는메뉴로 eclipse내에서분산되어있는플러그인들의기능

(eGovFrame에서필히사용되어지는기능)을빠르게접근할수있는통합메뉴제공

2.구현 도구

* 세부 메뉴 항목별 설명

 Start

- New Core Project : eGovFrame Core Project 생성
- New Web Project : eGovFrame Web Project 생성
- New Template Project : eGovFrame Template Project생성

Simple Homepage
Portal Site
Enterprise Business
Common All-in-one

- New Mobile Project : eGovFrame Mobile Project 생성
- New Mobile Template Project : eGovFrame Mobile Template Project 생성

- Mobile Common All-in-one
- New DeviceAPI Template Project : eGovFrame DeviceAPI Template Project 생성
- New Batch Template Project : eGovFrame Batch Template Project 생성

 Analysis

- New Usecase Diagram : Usecase Diagram 생성
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2. eGovFrame IDE (2/4) - eGovFrame Menu

eGovFrame Perspective에서만활성화되는메뉴로 eclipse내에서분산되어있는플러그인들의기능

(eGovFrame에서필히사용되어지는기능)을빠르게접근할수있는통합메뉴제공

2.구현 도구

* 세부 메뉴 항목별 설명

 Design

- New ER Diagram : ER Diagram 생성
- New Class Diagram : Class Diagram 생성
- New Sequence Diagram : Sequence Diagram 생성

 Implementation

- Add eGovFrame Common Component : Common Component 생성
- Add Mobile Common Component : Mobile Common Component 생성
- Add DeviceAPI Template : eGovFrame DeviceAPI Template Project 생성
- New SQL Map Config : SQL Map Config 파일의 생성
- New SQL Map : SQL Map 파일의 생성
- New Mapper Configuration : Mapper Configuration 파일 생성
- New Mapper : Mapper 파일 생성
- Show DBIO Search View : DBIO Search View를 나타나게 함
- XML Based CodeGen : UML XML파일 기반으로 소스코드 생성
- New Batch Job : Job/Step/Item 구성해서 배치작업 파일 생성
- New Batch Job Launcher : 배치작업 실행파일 생성
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2. eGovFrame IDE (3/4) - eGovFrame Menu

eGovFrame Perspective에서만활성화되는메뉴로 eclipse내에서분산되어있는플러그인들의기능

(eGovFrame에서필히사용되어지는기능)을빠르게접근할수있는통합메뉴제공

2.구현 도구

* 세부 메뉴 항목별 설명

 Test

- Batch Job Test : Batch Job 테스트

 Configuration

- Customize Development Tool : 필요한 기능을 선택적으로 설치
- Server Connection Management · Show SVN Repositories View : SVN Repositories View를 나타나게 함

· Nexus : Nexus Repository 정보 관리
- Add Plug-In : 플러그인 설치
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* 세부 메뉴 항목별 설명

 Start

- New Batch Template Project : eGovFrame Batch Template Project 생성

 Implementation

- New Batch Job : Job/ Step/ Item을 구성해서 배치 작업 파일 생성
- New Batch Job Launcher : 배치 작업 실행 파일 생성

 Test

- Batch Job Test : 구성한 배치를 JUnit을 활용하여 테스트

eGovFrame Perspective에서만활성화되는메뉴로 eclipse내에서분산되어있는플러그인들의기능

(eGovFrame에서필히사용되어지는기능)을빠르게접근할수있는통합메뉴를제공

2.구현 도구2. eGovFrame IDE (4/4) – eGovFrame Batch Menu
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3. UML 작성

오픈소스중선정된 UML작성도구는AmaterasUML로써 UseCase Diagram, Class Diagram작성기

능을제공

 UseCase Diagram작성

– Use Case Diagram작성할수있는기능을제공

 Class Diagram작성

– Class Diagram 작성할수있는기능을제공

제약사항

– UML 1.4기반으로설계작업가능

– UML 2.0지원하지않음

UseCase
Diagram 작성

Class Diagram
작성

2.구현 도구
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4. ERD 작성

오픈소스중선정된 ERD작성도구는 AmaterasERD로서논리모델과물리모델작성을지원

ERD생성

– Entity정의와 Entity간의관계를표현할수있는작업창

 DDL작성

– 도구를이용해작성된 ER Diagram으로 Oracle, PostgreSQL,

MySQL, hsqldb등에맞게 DDL스크립트를생성

 Reverse Engineering지원

– Oracle, PostgreSQL, MySQL, hsqldb등의 Database로부터

테이블 Import가가능

테이블명세서 Export

– 도구를이용해작성된 Table들의명세서를 HTML형식 Export

제약사항

– ERWIN모델링도구와호환불가

2.구현 도구
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5. DBIO 작성(1/12)

DBIO Editor는 iBatis SQL Map API 를통해 DBIO를개발하고자 할때 이를쉽고편리하게작성할

수있도록 다음과같은 Editor기능을제공 (iBatis전용)

* iBatis SQL Map API 에서는기본적으로 SQL Map파일과 SQL Map설정파일이요구된다.

 SQL Map Editor
- SQL Maps 파일을 UI형태로편집가능하도록지원

 SQL Map Config Editor
- SQL Maps설정파일을 UI형태로편집가능하도록지원

2.구현 도구
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5. DBIO 작성(2/12)- SqlMap Config Editor

SqlMap Config Editor는 iBATIS SQL Maps설정파일을 UI 형태로편집가능하도록지원

 Transaction Manager

– 주요트랜잭션 Type과 DataSource Type에필요한 Properties항목을정의한다.

 SqlMap 목록

– SqlMap항목을추가,삭제,신규생성하고 SQLMapConfig파일내등록을지원한다.

SQL Map 목록

Transaction Manager

2.구현 도구
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5. DBIO 작성(3/12)- SqlMap Editor 화면구성

그룹별구성요소 Tree

– 구성요소생성,삭제,검색,바로가기기능

사용자 Layout 조정

– 수평,수직레이아웃선택기능

 In/out Section

– Parameter, Result설정(class, map선택)

 Query Section

– SQL쿼리작성시 Query Builder기능제공

 Test Section

– 쿼리에따른 Parameter Name자동설정

– Row Limit (쿼리테스트결과행길이제한)

– 쿼리 Test결과에따른 VO자동생성기능

 Query Result :쿼리수행결과확인

 Source Tab : SqlMap XML편집기능지원

 SqlMap Outline View

– 구성요소바로가기기능지원

그룹별 구성요소
Tree

In/Out Section

Query Section

Query Result

SQL Map
Outline

뷰

Test Section

사용자 Layout 조정

Source Tab

2.구현 도구

SqlMap Editor는 iBatis SQL Maps파일을 UI 형태로편집가능하도록지원하는도구
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5. DBIO 작성(4/12)- 쿼리 작성 2.구현 도구

SqlMap Editor에서는쿼리작성을용이하게하기위해 Query Builder기능을제공함
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5. DBIO 작성(5/12)- 쿼리 Test 및 결과 확인

SqlMap Editor는 Test Section과 Result View를통해쿼리테스트기능을지원함

쿼리 Test절차

① Query Section에서 DB Info를선택한다.

② Query Section에서 Query를작성한다.

③ Test Section에서 Parameter값을입력한다.

④결과값을확인한다

 Test Section 버튼설명

- Set Param : Parameter Name을자동세팅한다.

- Query Test :쿼리테스트를수행한다.
- Create VO :쿼리결과에따른 VO를생성한다.
- Row Limit :쿼리결과행길이제한 (기본값=100)

④ Query Result 확인

① DB Info 를 선택

② Query 작성

③ Parameter 값 입력

2.구현 도구
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5. DBIO 작성(6/12)- VO 자동 생성

SqlMap Editor는개발자편이성을위해 VO(Value Object)를자동생성기능제공

①“Create VO ”클릭

② VO Class명 입력

③ 쿼리 수행 결과에 따른
VO Class가 생성됨

2.구현 도구
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5. DBIO 작성(7/12)

DBIO Editor는 MyBatis API 를통해 DBIO를개발하고자 할때 이를쉽고편리하게작성할수있

도록 다음과같은 Editor기능을제공 (MyBatis전용)

* MyBatis API 에서는기본적으로Mapper파일과Mapper설정파일이요구된다.

Mapper Editor
- Mapper 파일을 UI형태로편집가능하도록지원

Mapper Configuration Editor
- Mapper설정파일을 UI형태로편집가능하도록지원

2.구현 도구
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5. DBIO 작성(8/12)- Mapper Configuration Editor

Mapper Configuration Editor는 MyBATIS Mapper설정파일을 UI 형태로편집가능하도록지원

 TypeAliases

– typeAlias alias명과 type속성을정의한다.

 Mapper 목록

– Mapper항목을추가,삭제,신규생성하고 Mapper Configuration파일내등록을지원한다.

TypeAlias

2.구현 도구

Mapper 목록
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5. DBIO 작성(9/12)- Mapper Editor 화면구성

그룹별구성요소 Tree

– 구성요소생성,삭제,검색,바로가기기능

사용자 Layout 조정

– 수평,수직레이아웃선택기능

 In/out Section

– Parameter, Result설정(type, map선택)

 Query Section

– SQL쿼리작성시 Query Builder기능제공

 Test Section

– 쿼리에따른 Parameter Name자동설정

– Row Limit (쿼리테스트결과행길이제한)

– 쿼리 Test결과에따른 VO자동생성기능

 Query Result :쿼리수행결과확인

 Source Tab : Mapper XML편집기능지원

 Mapper Outline View

– 구성요소바로가기기능지원

그룹별 구성요소
Tree

In/Out Section

Query Section

Query Result

Mapper
Outline
View

Test Section

사용자 Layout 조정

Source Tab

2.구현 도구

Mapper Editor는 MyBatis Mapper파일을 UI 형태로편집가능하도록지원하는도구
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5. DBIO 작성(10/12)- 쿼리 작성 2.구현 도구

Mapper Editor에서는쿼리작성을용이하게하기위해 Query Builder기능을제공함
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5. DBIO 작성(11/12)- 쿼리 Test 및 결과 확인

Mapper Editor는 Test Section과 Result View를통해쿼리테스트기능을지원함

쿼리 Test절차

① Query Section에서 DB Info를선택한다.

② Query Section에서 Query를작성한다.

③ Test Section에서 Parameter값을입력한다.

④결과값을확인한다

 Test Section 버튼설명

- Set Param : Parameter Name을자동세팅한다.

- Query Test :쿼리테스트를수행한다.
- Create VO :쿼리결과에따른 VO를생성한다.
- Row Limit :쿼리결과행길이제한 (기본값=100)

④ Query Result 확인

① DB Info 를 선택

② Query 작성

③ Parameter 값 입력

2.구현 도구
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5. DBIO 작성(12/12)- VO 자동 생성

Mapper Editor는개발자편이성을위해 VO(Value Object)를자동생성기능제공

①“Create VO ”클릭

② VO Class명 입력

③ 쿼리 수행 결과에 따른
VO Class가 생성됨

2.구현 도구
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6. Code Generation - 모델기반

설계모델을기반으로 Skeleton소스코드를생성하는기능을제공

 절차

1. 구현도구에서클래스다이어그램(*.cld)를더블클릭한다.

2. 클래스다이어그램에디터화면내에서오른쪽버튼클릭하여메뉴에서 “eGovFrame > Model Based CodeGen”메뉴를클릭한다.

3. Output Folder입력항목에소스디렉토리를입력하고 “Finish”버튼을클릭한다.

2.구현 도구



52
Page l 52

7. eGovFrame Java Project 2.구현 도구

eGovFrame 기반의 어플리케이션
개발에 적합한 프로젝트 환경 구성

2가지 생성 방식

프로젝트생성마법사는일반 혹은Web기반프로젝트자동생성기능을제공

 eGovFrame Core Project

-일반적인 JAVA Project생성

 eGovFrame Web Project

- Web기반프로젝트생성
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8. Common Component(1/3) - 기본설치

개발자의편의성을위하여전자정부표준프레임워크에서제공하는공통컴포넌트 251종의설치마법사

를제공

2.구현 도구

① 설치할 공통 컴포넌트를 선택

② 테이블 생성 방식 선택

기본설치 선택 시
Finish 버튼 활성화

사용자지정 선택 시
Next 버튼 활성화
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8. Common Component(2/3) – 사용자 지정

개발자의편의성을위하여전자정부표준프레임워크에서제공하는공통컴포넌트 251종의설치마법사

를제공

2.구현 도구

③ 테이블 생성

④ 테이블 생성 결과 확인

② Connection Test 수행

 Table생성절차

① Select DB에서사용할 DB를선택한다.

② Connection Test를수행한다.

③ Create Table버튼을눌러테이블을생성한다.

④테이블생성결과를확인한다.

('Prepared', ‘Success', 'Already Exist', 'Failed’의

4개의결과값으로결과확인가능)

① DB 선택
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8. Common Component(3/3) – 공통 컴포넌트 설정

개발자의편의성을위하여전자정부표준프레임워크에서제공하는공통컴포넌트 251종의설치마법사

를제공

2.구현 도구

운영체제유형

– 사용자의운영체제를선택한다.

메인페이지

– 선택한공통컴포넌트설치후실행시시

작화면을보여준다.

 G4C연결용 IP

– G4C인증용 IP를보여준다.

 Select DB

– Data Source Explorer에사용자가등록한

DB중공통컴포넌트설치시선택한 DB

정보가선택된다.

※설정변경시변경된내용은
globals.properties에서확인이가능하다.
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9. Batch Job

배치작업생성도구를통해 Job, Step등일괄처리를위한기본기능부터 Flow Control, Partitioning

등확장기능까지설정값입력만으로사용자가원하는배치작업파일을생성

① 배치 Job 정보 생성

② 배치 Step 정보 생성

③ Reader/Writer 정보 생성

④ 배치 작업 파일 생성

2.구현 도구

배치작업생성절차

①배치 Job정보를생성한다.

② Batch Step정보를생성한다.

③ Reader/Writer정보를생성한다.

④배치작업파일을생성한다.
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10. Batch Job Launcher

배치실행생성도구를통해 Job Launcher, Job Operator등배치실행정보를생성하고,필요시사용

자가현재사용중인 DB정보를배치작업에서활용할수있도록하는기능을제공

① 배치 Job Execution 정보 생성

③ 배치 실행 파일 생성

2.구현 도구

② DataSource 정보 생성

배치실행작업생성절차

①배치 Job Execution정보를생성한다.

② DataSource정보를생성한다.

③배치실행파일을생성한다.
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11. Batch Configuration

배치개발환경사용시 Job Parameter, Job Reader/Writer, Listener를직관적으로등록및사용하기

위한관리환경을제공

2.구현 도구

 Job Parameter

-배치개발환경에서제공하는테스트마법사를

이용할경우사용자의편의성을위해배치구성

파라메터를추가하는관리환경을제공

Job Reader/Writer

- 배치수행시사용되는입력데이터를등록하

여사용할수있는관리환경을제공

-배치수행시사용되는출력데이터를등록하

여사용할수있는관리환경을제공

 Listener

- 배치수행시각 Job, Step, Chunk의 Pre혹은

Post에서다양한이벤트를잡아낼수있는

Listeners관리환경을제공

Reader/Writer 선택

Reader/Writer 생성 버튼

Reader/Writer 생성 정보
입력
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12. eGovFrame Template Project(1/2)

 Simple Homepage

-메인페이지,사용자관리,공지사항관리,

게시판관리,안내관리기능제공

 Portal Site

-포털공지사항관리,사용자관리,권한관리,

포털초기화면관리,포털공지사항관리,

포털 FAQ관리,포털 행사참가관리기능제공

 Enterprise Business

-메인페이지,업무사용자관리,공지사항관리,

게시판관리,권한관리,메뉴관리기능제공

 Common All-in-one

-공통컴포넌트 251종의모든기능제공

2.구현 도구

유형별템플릿프로젝트를자동생성하는기능을제공
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① 배치 템플릿 입력 리소스 유형 선택

② 배치 템플릿 실행 유형 선택

③ 프로젝트 정보 입력

④ 실행 가능한 템플릿 프로젝트
생성

2.구현 도구12. eGovFrame Template Project(2/2) - Batch

배치템플릿생성도구를실행한후,입력리소스유형과실행유형의선택만으로총 6종류의예제프로

젝트를생성

배치실행작업생성절차

①배치 Job Execution정보를생성한다.

② DataSource정보를생성한다.

③배치실행파일을생성한다.
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13. Debug(1/2) - Local Debugging

 중단점 설정

– 디버깅 중 프로그램의 의심되는 부분을 집중적으로 분석하기 위해

Break point를 설정해 디버깅 포인트를 지정한 부분을 하이라이트

 스텝단위 진행

– 프로그램을 한 스텝씩 진행하면서 프로그램의 실행흐름과

내부 상태를 확인

 스텝 필터링

– 필터링 대상 프로그램의 경우 Step Over와 같이 동작하고, 필터링 대상이 아니면 Step Into와 같이 동작한다. Debug View의

Use Step Filters 버튼을 눌러 활성화

 Evaluating Expressions

– 수행 중인 프로그램을 중지시키지 않고

상태를 확인할 수 있는 기능을 제공

 Variables View

– Variables View를 통해 메소드에서

사용 중인 변수 값의 상태를 확인할 수 있는 기능 지원

2.구현 도구

로컬또는원격으로실행중인프로그램에서오류를발견하고진단할수있는디버거제공
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 디버깅환경설정

– WAS환경설정파일에 “-Xdebug -Xnoagent -Xrunjdwp:transport=dt_socket,address=8000,server=y,suspend=n –server”를정의

(Jeus서버기준)

 절차

1.먼저위의환경설정으로원격지서버를가동하고해당 Java프로그램을원격서버에 Deploy한것을전제로한다.

2.메뉴>Run > Debug Configurations…클릭.

3. Remote Java Application에서마우스오른쪽버튼을클릭하여 “NEW”를실행

4. Connection Properties를입력하고적용(“Apply”)한뒤 “Debug”버튼클릭

5.웹브라우저에서해당프로그램을실행하면디버깅이진행된다.

*디버그방법(BreakPoint등)은

로컬디버깅과동일하다.

원격컴퓨터의WAS(Jboss, JEUS, WebLogic)에서실행되는어플리케이션을 디버깅

13. Debug(2/2) - Remote Debugging 2.구현 도구
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14. Code Inspection

정의된규칙을기반으로소스코드를검사하여,오류및위험요인을식별하여알려주는기능제공

 절차

1. eclipse개발환경의 Package Explorer에서프로젝트의컨텍스트메뉴에서 PMD>Check Code With PMD를클릭한다.

2. 소스코드검사가실행되며실행후 PMD Perspective에서검사결과를확인한다.

2.구현 도구
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15. Server Connection Management(1/3)(서버 연동 정보 관리)

eGovFrame 통합메뉴를통해 SVN Repositories View를연동하는기능을제공한다.

 SVN Repositories View

1. eGovFrame통합메뉴 > Configuration > Server Connection Management > Show SVN Repositories View를클릭한다.

2. 화면하단에 SVN Repositories라는 View가열리는것을확인한다.

2.구현 도구
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15. Server Connection Management(2/3)(서버 연동 정보 관리)

Nexus Repository를등록,수정및삭제하는기능을제공

 Nexus(Preferences)

1. eGovFrame통합메뉴에서 eGovFrame > Configuration > Server Connection Management > Nexus를선택한다.

2. Preferences페이지에서 New버튼을클릭하여새로운 Nexus repository를추가한다.

2.구현 도구
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15. Server Connection Management(3/3)(서버 연동 정보 관리)

등록된 Nexus Repository정보를대상프로젝트에적용하는기능을제공

 Nexus(Properties)

1. 대상이되는프로젝트를선택후우클릭하여 Properties를선택한다.

2. Properties페이지에서 eGovFrame > Nexus를선택한다.

3. 기설정된 Nexus정보중대상프로젝트에서사용할 repository를선택(체크박스)후 OK버튼을클릭하여적용한다.

※등록된 Nexus Repository가없을경우, Configure Workspace Settings링크를클릭하여나타나는 Preferences창에서 Nexus

Repository를추가할수있다.

2.구현 도구
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16. 참고 자료

 Eclipse Home

– http://www.eclipse.org/

 Amateras UML

– http://amateras.sourceforge.jp/cgi-bin/fswiki_en/wiki.cgi?page=AmaterasUML

 Amateras ERD

– http://amateras.sourceforge.jp/cgi-bin/fswiki_en/wiki.cgi?page=AmaterasERD

2.구현 도구
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1. Maven개요

2. Maven디렉터리구조

3. 빌드 Lifecycle

4. Maven플러그인

5. 의존성관리메커니즘

6. Maven저장소

7. 프로젝트객체모델(Project Object Model)

8. Maven이클립스통합: m2eclipse

9. 참고자료

3.개인빌드
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불필요한설정을최소화한다는개념아래 Ant와같은빌드기능을제공할뿐아니라구조화된빌드기

능을통해 learning curve및재사용성을향상시킴

Maven특징

1. Maven 개요 (1/2)

Maven 장점 Maven 단점

• repository 관리의 불편함
- Maven 프로젝트의 급속한 발전으로 central repository
가 제공하는 라이브러리들이 급속히 증가하고 있으나 아직
3rd 파티 라이브러리 등 미제공 라이브러리들이 있음

• pom.xml 파일 관리
-메이븐 프로젝트 관리에 대한 모든 내용이 pom.xml 파
일에 담기게 되므로 길고 장황하게 될 수 있음

• 프로젝트에 특화된 복잡한 빌드 기능 제약
- 메이븐 프로젝트 특성상 소프트웨어 빌드에 통용되는 라
이프 사이클을 제공하고 있어 세부 항목 또는 특화된 빌드
환경에 대한 지원이 미약함

• 뛰어난 의존성 관리
의존성 자동 업데이트
저장소를 통한 라이브러리 일괄 관리

•모든 프로젝트에 걸쳐 쉽게 적용 가능한 일관적인 사용법

•라이브러리 및 메타 데이터 저장을 위한 지속적으로 확장
되고 있는 저장소

•쉽게 작성 가능한 플러그 인을 통한 확장성

•동시에 다수의 프로젝트 핸들링 할 수 있는 쉬운 설정 기반
의 메커니즘

•간단한 설정을 통한 배포 관리

•Java, C++ 등 다수의 프로그래밍 언어 지원

3.개인빌드
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1. Maven 개요 (2/2)

의존성관리,라이브러리관리,빌드생명주기 및단계객체모델을갖는프로젝트관리도구로표준화

된빌드 기능뿐만아니라리포팅및 documentation생성기능등을제공

Maven아키텍처

– 프로젝트객체모델(POM):메이븐엔진내장 + POM.XML파일에서선언적으로제공

– 의존성관리모델:로컬및리모트저장소를이용하여관리

– 빌드생명주기와각단계:잘정의된단계들과빌드사이클에따라플러그인들을조율

POM.XMLPOM.XML Repositories
(local and
remote)

Repositories
(local and
remote)

Project Object
Model

Dependency
Management

Model

Project life cycle and phases

Plugins

Source
files

GeneratedGenerated
files

ResourcesResources Binaries
Packaged
libraries

3.개인빌드
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2. Maven 디렉터리 구조

Best practices을기반으로정규화된디렉터리구조를제공하고있으며모든소스파일들은 /src

디렉터리밑에빌드된 output은 /target디렉터리밑에위치함

Maven 표준 디렉터리 구조 디렉터리/파일 설명

/pom.xml
프로젝트객체모델.해당프로젝트에대한
전반적인정보를갖는다.

/src/main/java Java소스파일위치

/src/main/resources 배포할리소스, XML, properties, …

/src/main/webapp
웹어플리케이션관련파일위치(WEB-INF,
css등)

/src/test/java 테스트케이스 java소스

/src/test/resources 테스트케이스리소스

/target 빌드된 output이위치하는디렉터리

3.개인빌드
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3. 빌드 Lifecycle (1/2)

메이븐빌드는소프트웨어프로젝트의핵심적인빌드라이프사이클개념을따르고있으며빌드부터

artifact의배포까지의라이프사이클을정의하고있음

빌드 생명 주기 설명 Maven2 라이프 사이클 단계(phase)

$mvn compile

생명주기단계 설명

validate 현재설정과 POM의내용이유효한지확인

generate-sources
코드생성기가이다음의단계들에서컴파일되고처
리할소스코드를생성하기시작하는순간

compile
소스코드를컴파일한다.컴파일된클래스들은타깃
디렉터리트리구조에저장된다.

test
컴파일된단위테스트를실행하고그결과를표시한
다.

package
실행가능한바이너리파일들을WAR나 JAR같은배
포용압축파일로묶는다.

install 압축파일을로컬메이븐저장소에추가한다.

deploy 압축파일을원격메이븐저장소에추가한다.

3.개인빌드
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3. 빌드 Lifecycle (2/2)

이클립스에서빌드라이프사이클에서정의한각단계들실행하기

메이븐프로젝트 -> Run As -> Maven build.. Goals: clean install

3.개인빌드
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4. Maven 플러그인 (1/2)

메이븐은대부분의빌드작업시에플러그인을활용하며메이븐 엔진이생명주기단계들과플러그인을

바인딩시켜빌드작업을컨트롤함

 플러그인플랫폼으로써의메이븐 –확장용이

자주사용하는플러그인들을모아패키징한상태로
배포

대부분의개발작업시에추가플러그인불필요

Maven Plugins

가용한 Maven플러그인매트릭스

단계 Plugin 설명

compile maven-compiler-
plugin

소스 코드 컴파일

test maven-surefire-
plugin

단위 테스트 실행

package maven-jar-plugin 컴파일 된 바이너리 파일들
로부터 jar 패키지 생성

emma maven-emma-
plugin

Code coverage report 생
성

3.개인빌드



75
Page l 75

4. Maven 플러그인 (2/2)

 pom.xml에서의메이븐플러그인선언예제

3.개인빌드
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5. 의존성 관리 메커니즘 (1/2)

POM에서선언적인 dependency설정으로빌드및배포시에필요한 라이브러리들을관리하고로컬

및원격저장소에서선언된라이브러리들을다운로드받아사용함

의존성 설정

1. 로컬 저장소에서의존성확인

2. 원격 저장소리스트에서의존성확인

3. 1과 2가 실패하면의존성에러보고

의존성 분석 순서

1. <groupId>: 부분적인프로젝트나조직
에서의라이브러리집합을식별하기위
해제공

2. <artifactId>:프로젝트의실제이름으
로 groupId와합쳐져프로젝트식별에
쓰임

3. <version>:선언한의존성 artifact의버
전으로프로젝트내에서사용하는
artifcat의일관성을추구할수있음

의존성 선언 항목

의존성 scope
• compile:기본값으로모든클래스패스에서사용가능
• provided: 컴파일과유사하나패키지에는포함되지않는다.컨테이너나

JDK에서제공.예) Servlet API for web apps
• runtime:컴파일러가아닌런타임시에만사용됨
예) JDBC dirvers

• test:테스트단계에서만유용함 예)Junit
• system: provided와유사하나개발자가직접 JAR파일을제공해야함.
저장소에서지정한 dependency를찾지않는다.

3.개인빌드
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5. 의존성 관리 메커니즘 (2/2)

 pom.xml파일에서의의존성설정및의존성분석

3.개인빌드
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6. Maven Repository

artifact들의저장소로로컬및리모트 repository로구성되며프로젝트는 pom.xml에서선언한

dependency들을저장소로부터불러와서사용함

메이븐 저장소 구조 Nexus 연동

•로컬 repository는 artifact들을로컬파일시스템에 cache하

는기능으로리모트 repository에서다운로드받아 artifact들을

저장하고관리한다.

•리모트 repository는 주 로 HTTP서버로 3rd파티에서제공

하는 artifact들을제외한거의모든 artifact들을제공한다.

• Nexus는메이븐 repository관리툴로리모트 repository의단

점을보완하고 maven프로젝트의사용 편의성을높이기 위

해사용된다.각개발자들은리모트 repository가아닌 Nexus

에서 dependency을다운받아사용함으로써 프로젝트내의

artifact버전등의일관성을유지하고 3rd파티 artifact등라이

브러리를 효과적으로공유할수있다.

3.개인빌드
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7. 프로젝트 객체 모델 (POM) (1/2)

프로젝트의구조와내용을설명하고있으며 pom.xml파일에프로젝트관리및빌드에필요한환경설

정,의존성관리등의정보들을기술함

3.개인빌드

– 프로젝트의세부메타데이터정보를포함

• 버전및설정관리,빌드환경,라이브러리저장소및의존성

Build Settings

Properties

Build

Packaging

Reporting

Project Information

Name

URL

Description

Artifact

Group Id

Version

Artifact Id

Inception Year

Dependencies

POM.XML

Dependency Mgt.Dependencies

Maven Environment

Prerequisites Repositories

Profiles

Profile(activation,…)

Repositories

Plugin Repositories

Distribution Management

Environment Information

Issue Management

CI Management

Mailing Lists

SCM
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7. 프로젝트 객체 모델 (POM) (2/2)

프로젝트의 pom.xml파일에빌드정보들을기술함

<project xmlns="http://maven.apache.org/POM/4.0.0" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://maven.apache.org/POM/4.0.0http://maven.apache.org/maven-v4_0_0.xsd">

<modelVersion>4.0.0</modelVersion>
<groupId>egovframework.dev.com</groupId>
<artifactId>egovframework-dev-com</artifactId>
<version>1.0</version>
<packaging>war</packaging>
<name>egovframework-dev-com Maven Webapp</name>
<dependencies>

<dependency>
<groupId>junit</groupId>
<artifactId>junit</artifactId>
<version>4.12</version>
<scope>test</scope>

</dependency>
</dependencies>
<plugins>

<plugin>
<groupId>org.apache.maven.plugins</groupId>
<artifactId>maven-compiler-plugin</artifactId>
<configuration>

<source>1.8</source>
<target>1.8</target>
<encoding>UTF-8</encoding>

</configuration>
</plugin>

</plugins>
</project>

Artifact정보

의존성관리

플러그인선언

3.개인빌드
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8. Maven 이클립스 통합 : m2eclipse

m2eclipse는 Eclipse IDE에서 Maven을사용하기위한플러그인으로Maven프로젝트생성뿐아니

라 Maven빌드와WTP(Web Tools Project)의통합등다양한기능을제공함

m2eclipse 특징

• 메이븐프로젝트생성및불러오기

•의존성관리및의존성통합

• dependency자동다운로드및업데이트

•리모트 repository탐색기능제공

• POM파일관리화면제공및 dependency list에대한자동업
데이트

•다양한 SCM저장소로부터메이븐프로젝트 check out

•이클립스에서메이븐멀티모듈프로젝트생성기능제공

• Web Tools Project (WTP)와의연동

• aspectj Development Tools (AJDT)과의연동

• Subversion플러그인과의연동

3.개인빌드
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 배포된 eGovFramework Archetype을이용한메이븐프로젝트생성예

8. Maven 이클립스 통합 : m2eclipse – 프로젝트 생성 (1/2)

Maven 프로젝트 생성 Maven 프로젝트의 archetype 선택

configure..버튼클릭으로제공된 archetype을선택

eGovFramework에서는메이븐프로젝트생성을위해두가지
방식을제공하고있음

1.구현도구에서제공하는 Perspective를이용한 Maven프로
젝트생성

2. Maven archetype을이용한프로젝트생성
: ‘Archetype is a Maven project templating toolkit.’ -프로젝트
에특화된 pom.xml및 resource들을포함한 Maven프로젝트생
성

Maven Archetype종류
1. 표준 Archetype
• maven-archetype-j2ee-simple
• maven-archetype-quickstart
• maven-archetype-portlet

2. eGovFramework Archetype
• egovframework-maven-webapp

* Maven제공 Archetype종류:
http://repo1.maven.org/maven2/org/apache/maven/archetypes/

3.개인빌드
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8. Maven 이클립스 통합 : m2eclipse – 프로젝트 생성 (2/2)

 eGovFramework Archetype을이용한 Maven프로젝트

3.개인빌드

– Spring기반의 dependency들을기본으로제공함
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8. m2eclipse – Maven 기본 기능

 m2eclipse에서제공하는메뉴에서 메이븐설정및연동기능을호출할수있음

m2eclipse Maven 기능 Update Dependencies 기능

pom.xml에 dependency를추가하고 update
dependencies메뉴를선택하면저장소에서해당
artifact를찾아프로젝트에 Cache함

3.개인빌드
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8. m2eclipse – Maven 기본 빌드 기능

m2eclipse는이클립스의 Run As 메뉴에 Maven기본생명주기단계를추가하여빌드편의성을제공함

m2eclipse Maven 빌드 기능 Maven install 기능

Maven install메뉴를선택하여생명주기의각단계를
실행하고프로젝트를패키징하여로컬 repository에저
장함

3.개인빌드(Maven)
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9. 참고 자료

 Apache Maven

– http://maven.apache.org/

 Maven Central Repository

– http://mvnrepository.com/

 M2eclipse

– http://m2eclipse.codehaus.org/

 Nexus

– http://www.sonatype.com/books/nexus-book/reference/
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1. 테스트 (1/2)

대상 결과입력

성공

실패

테스트(Test)

– 테스트대상에입력값을넣었을때그결과가성공혹은실패의결과를내는것이다.

Here! Here!

수동테스트 vs.자동테스트

4.테스트 도구
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1. 테스트 (2/2)

수동테스트 자동테스트

장점 쉽다.간편하다.

테스트불가능한상황이별로없다.

언제든지같은테스트를여러번수행가능

기존테스트는새테스트를작성하는발판이된다.

(지식축적)

빠르므로자주돌려볼수있다.

개발자가코드개선활동을수행할때에도회귀테스트(Regression

Test)를자주할수있다.

단점 휘발성

테스트항목이늘어난다면?

다른사람에게테스트내용을설명하기어려움

재현하기어려움

코드로작성해야한다.

–기술,노하우가필요하다

–코드로테스트를작성할수없는상황이있다.

(수동테스트와공조)

–테스트도관리대상이다.

모듈화가잘되어있어야한다.

–디자인의개선필요

–Legacy Code의어려움

4.테스트 도구
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2. 개요 (1/2)

테스트도구

테스트대상모듈

결과 리포트

Test
Reporting

Test
Automation

테스트클래스

구현도구

작성

실행
작성

OOService

OODao

OOServiceTest

MockDao

DB
DB

DaoTest

테스트도구는 Unit Test, Mock, DB Test Framework을통해 TestCase작성을지원하고, Test

Automation, Test Coverage, Test Reporting등의기능을제공함

Test
Coverage

<<Dataset>>
자동화

리포팅

TestCase 작성
Test 수행

분석

Unit Test
Framework

Mock
Framework

DB Test
Framework

4.테스트 도구
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2. 개요 (2/2)

테스트도구사용프로세스

write
TestCases

run
TestCases

analyze
Test Coverage

run automatically
TestCases

report
Test results

4.테스트 도구
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3. Unit Test (1/3)

Unit Test란대상코드에대해테스트하고자개발자가작성한코드로서,주로특정메소드를실행해서

그결과가기대값과일치하는지확인하는형태이며, Unit Test는서로독립적으로수행되어야함.

효과

– 작성한코드의설계개선작업시,코드품질에대한확신

– 코드수정시버그를쉽게찾을수있게해줌

– 자동화된회귀테스트 (Regression Test)를가능하게해주는 Source가됨

작성범위

– 주요흐름에대한테스트 (the happy path)

– 또다른주요흐름에대한테스트 (the main alternative path)

– 경계조건에대한테스트 (null인자체크등)

– Exception테스트 (Exception발생하는조건에대한테스트)

4.테스트 도구
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3. Unit Test (2/3)

구성

– 테스트프레임웍을사용하는 Class

– 공용으로사용하는테스트데이터 (test fixture)

– 테스트데이터준비 (Setup of test data)

– 테스트메소드 (testXXX)

• (테스트별준비)

• 테스트대상메소드실행

• assert문을이용한결과확인

(assertTrue, assertEquals etc.)

– (내부메소드)

대상 결과입력

성공

실패

1:
2:
3:
4:
5:
6:
7:
8:
9:
10:
11:
12:
13:
14:
15:
16:
17:
18:
19:
20:
21:
22:
23:
24:
25:
26:
27:
28:
29:
30:
31:
32:
33:
34:

public class UserAdminTest {

/* Class under test */
private UserAdmin userAdmin;

/* A simple test user */
private User user; // Test Data (Fixture)
/* An administrator role */ //
private Role adminRole; //

/**
* Initializes the test fixture.
*/
@Before
public void setUp() throws Exception {

userAdmin = new UserAdmin();
user = new User("John", "Doe"); // Test Data Setup
adminRole = new Role("Administrator"); //

}

/**
* Test for method with ...
*/
@Test
public void testAddUser() {

user.setAge(18); // Extra Test Setup
userAdmin.addUser("jdoe", user, adminRole); // Use

Test Data

User result = userAdmin.getUser("jdoe");
assertEquals("John", result.getFirstName());
assertEquals("Doe", result.getLastName());

}
}

4.테스트 도구
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3. Unit Test (3/3) – JUnit

JUnit은자바프로그래밍언어를위한 Unit Test Framework로, Unit Test코드를작성하고자동화된

테스트를수행할수있는기능을제공함

4.테스트 도구
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4. Mock (1/2)

Mock객체는 Unit Test의독립성(isolation)을높여주기위해사용하며,테스트하고자코드와관련이

있는객체(collaborator)를흉내내어 Unit Test를수행할수있도록도와주는객체임

Mock객체를사용하는경우

– 진짜객체를준비,설정하기어렵다

– 진짜객체가느리다.

– 진짜객체가사용자인터페이스를갖거나그자체이다.

– 진짜객체가아직없다.

Mock사용종류

– 이미구현된 Mock객체사용 : Spring test (web, jndi), mockrunner

– EasyMock, JMock, Mockito등의 Mock라이브러리사용

– Mock으로사용할가짜클래스직접구현

4.테스트 도구
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4. Mock (2/2)

 Easymock + Unitils샘플

1:
2:
3:
4:
5:
6:
7:
8:
9:
10:
11:
12:
13:
14:
15:
16:
17:
18:
19:
20:
21:
22:
23:
24:
25:
26:
27:
28:
29:
30:
31:

@RunWith(UnitilsJUnit4TestClassRunner.class)
public class EgovControllerTest {

@Mock
@InjectIntoByType
private EgovService mockService;

@TestedObject
private EgovController egovController = new EgovController();

@Test
public void testSelectList() throws Exception {

assertNotNull(egovController);
expect(mockService.selectList()).andReturn(

Arrays.asList(new Message(101), new Message(102)));
EasyMockUnitils.replay();

List<Message> resultList = egovController.selectList();
assertNotNull(resultList);
assertEquals(2, resultList.size());

}

@Test
public void testInsert() throws Exception {

mockService.insert(makeVO());
EasyMockUnitils.replay();

SessionStatus status = new SimpleSessionStatus();
String view = egovController.add(makeVO(), status);

}
}

Mock으로 생성할 인터페이스에 대한 정의한
뒤, 테스트 대상 클래스에 Mock으로 정의한
클래스를 세팅한다.

리턴하지 않는 메소드를 Mock 객체에 정의
후 진짜 객체처럼 사용한다.

리턴값을 갖는 메소드를 Mock 클래스에 정의
하고 리턴값을 설정한 뒤, 진짜 객체처럼 사용
한다.

4.테스트 도구
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5. Batch Job Test

배치 테스트 도구를 통해 기 개발된 일괄처리 모듈에 대한 Junit 테스트 파일생성 및 테스트 수행과

함께, 기존에 생성한 Junit 테스트 파일을 재실행할 수 있는 기능을 제공

① Job 정보 선택 ② Job Launcher 정보 선택

④ 배치 테스트 파일 생성

⑤ 배치 테스트 수행

4.테스트 도구

③ Job Parameter 정보 선택 (선택사항)

배치테스트절차

①배치 Job정보를선택한다.

② Job Launcher정보를선택한다.

③필요시 Job Parameter정보를선택한다.

④ Generate Batch Test File버튼을클릭하여

배치테스트파일을생성한다.

⑤ Test버튼을눌러배치테스트를수행한다.
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6. DB Test

DB Test는 DAO와 DB모두를통틀어 Persistence layer를테스트하는것을말하며,테스트DB와테스

트데이터를준비하여실제로 DB를이용한단위테스트를수행함

 DB Test Framework

– DbUnit

 DbUnit기능

– DB데이터를 XML파일형태로 import/export

– DB연결, DB초기화

– DB의데이터가기대값과같은지확인

– 빌드도구를통한테스트자동화기능제공

효율적인 DB Test를위해

– DB구조만갖고있는단위테스트용 DB준비

– 각개발자마다별도의단위테스트용 DB공간

– Unitils, Spring Test활용

4.테스트 도구
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7. Test Automation (1/2)

 Test Suite

– TestCase모음

 Test Suite설정방법

– Test Suite Class작성

– 빌드도구의 batchtest묶음

작성된다수의 TestCase를자동으로수행하여소스단위의품질을높이고자함. CI서버와연계될때,

주기적인테스트수행으로인해목표시스템의품질을향상할수있음

<junit . . .>
<batchtest fork="yes" todir="${testreports.dir}">

<fileset dir="${testbuild.dir}">
<include name="**/*Test.class" />
<exclude name="**/Abstract*Test.class" />

</fileset>
</batchtest>

</junit>

@RunWith(Suite.class)
@SuiteClasses( { HttpRequestMockTest.class, SessionMockTest.class,
FileUploadMockTest.class, EmailMockTest.class, JDBCMockTest.class })
public class MockTestSuite {

}

1. Test Suite Class 작성

2. batchtest로 묶음

4.테스트 도구
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7. Test Automation (2/2)

 Ant (build.xml)

 Maven (pom.xml) goal : test

<junit forkmode="perBatch" printsummary="true" haltonfailure="yes" haltonerror="yes">
<classpath refid="master-classpath" />
<classpath refid="test-classpath" />
<classpath path="${testbuild.dir}" />

<formatter type="xml" />

<batchtest fork="yes" todir="${testreports.dir}">
<fileset dir="${testbuild.dir}">

<include name="**/*Test.class" />
<exclude name="**/Abstract*Test.class" />

</fileset>
</batchtest>

</junit>

<build>
<plugins>

<plugin>
<groupId>org.apache.maven.plugins</groupId>
<artifactId>maven-surefire-plugin</artifactId>
<configuration>

<reportFormat>xml</reportFormat>
<excludes>

<exclude>**/Abstract*.java</exclude>
</excludes>
<includes>

<include>**/*Test.java</include>
</includes>

</configuration>
</plugin>

</plugins>
</build>

4.테스트 도구
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8. Test Reporting - HTML (1/4)

Ant (build.xml) Maven (pom.xml)

<!-- Junit Test Result Report -->
<target name="junitreport" depends="tests">

<junitreport todir="${testhtml.dir}">
<fileset dir="${testreports.dir}">
<include name="TEST-*.xml" />

</fileset>
<report format="frames" todir="${testhtml.dir}" />

</junitreport>
</target>

<reporting>
<plugins>
<plugin>
<groupId>org.apache.maven.plugins</groupId>
<artifactId>maven-surefire-report-plugin</artifactId>
<version>2.4.2</version>

</plugin>
</plugins>

</reporting>

4.테스트 도구
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8. Test Reporting - Excel (2/4)

Ant – Default로사용한예

<path id="egov.lib">
<path refid="master-classpath" />
<path location="${antlib.dir}/egovtest/egovframework-dev-tst-ant.jar" />

</path>

<taskdef resource="egovtest.properties“ classpathref="egov.lib“ />

<!-- JUnit Excel Report -->
<target name="egovtest" depends="tests">

<egov-junitreport todir="${testxls.dir}">
<fileset dir="${testreports.dir}" includes="**/TEST-*.xml" />

</egov-junitreport>
</target>

Excel Reporting Ant Task 설정

Default 사용예

<target name="egovtest-full" depends="tests">
<egov-junitreport todir="${testxls.dir}"

outputname="egovtest-junit-full.xls"
templatepath="${basedir}/build/template-kr.xls"
summary="0,B,6"
packages="0,B,11"
lists="1,A,5">

<fileset dir="${testreports.dir}"
includes="**/TEST-*.xml" />

</egov-junitreport>
</target>

Ant –템플릿엑셀파일을별도로사용한예

4.테스트 도구
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8. Test Reporting - Excel (3/4)

Ant –템플릿엑셀파일을별도로사용한예

summary:0,B,6

packages:0,B,11

property 설명

todir 엑셀파일생성디렉토리

outputname 엑셀파일명

templatepath 템플릿엑셀파일정보

summary, packages, lists 각엑셀테이블의헤더위치정보 (sheet, column, row)

fileset 테스트결과 XML파일위치

lists 위치 : 1,A,5

4.테스트 도구
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8. Test Reporting - Excel (4/4)

<build>
<plugins>
<!-- Egovframework JUnit Excel Reporting -->
<plugin>

<groupId>egovframework.dev</groupId>
<artifactId>egovtest-maven-plugin</artifactId>
<version>1.0.0-SNAPSHOT</version>

</plugin>
</plugins>

</build>

 Maven (goal : egovtest:junit-xls)

4.테스트 도구
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1. 개요

 소스버전관리도구는시스템형상요소(소스및데이터)를문서화하고변경을소스버전관리절차

에따라관리하고,효율적으로처리하기위한통제환경을의미

 소스버전관리도구의특징및기능

– 형상요소(소스및데이터)에대한변경사항을관리

– 버전관리를수행하고,배포도구를통해변경사항을배포

– 일정주기에백업도구를통해백업을수행

 소스버전관리도구의구성요소및관계도

프로젝트 팀 소스 관리 도구 배포 도구

저장소

개발자

CMO

Check in/out
배포

백업

Configuration
Management

PL

5.형상관리
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2. Subversion 개요 (1/4)

 Subversion(SVN)의배경

– CVS의단점을개선하고 CVS를대체할목적으로개발되었음

– 오픈소스기반의소스버전관리도구 (http://subversion.tigris.org)

 CVS대비 Subversion의특장점

– CVS와거의동일한사용법. CVS사용자는누구나쉽게사용할수있음

– Commit단위: CVS는개별파일별로리비전관리, SVN은변경이발생하는체인지셋(Change Set)별로리비전

관리

– Atomic Commit:여러파일커밋시,어느하나의파일에서커밋이실패할경우, CVS는해당파일앞의경우는

커밋되고,뒷파일은그대로남아있지만, SVN은모두이전상태로롤백

– 트리별,파일별접근제어리스트지원

– 파일에대한이름변경/이동,디렉터리버전관리도지원

– CVS에비해빠른동작속도(Update/Branching/Tagging Time)

5.형상관리
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2. Subversion 개요 (2/4)

 SVN클라이언트 - Eclipse플러그인

– Subversive

• Polarion커뮤니티그룹에서개발

• Eclipse Ganymede버전부터 SVN클라이언트로공식채택

• 빠른 update,안정적인동작

• 공식웹페이지: http://www.eclipse.org/subversive/

– Subclipse

• Tigris커뮤니티그룹(Subversion개발커뮤니티)에서개발

• Subversion초창기폭넓은사용자확보

• Subversive대비느린 update,다수의버그로불안정

• 공식웹페이지: http://subclipse.tigris.org/

5.형상관리
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2. Subversion 개요 (3/4)

 저장소(Repository)

– 모든프로젝트의프로그램소스들과소스에대한변경사항이저장됨

– 네트워크를통해서여러사람이접근

– SVN에서는 Berkeley DB(Default)또는파일시스템(Optional)을저장소로사용

 저장소접근

① Eclipse 메뉴,
Window > Open Perspective
> Other... >
SVN Repository Exploring

③ 마법사에서,
URL과 Authentication 항목을 입력

② Eclipse 메뉴,
File > New >
Repository Location

5.형상관리
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2. Subversion 개요 (4/4)

 Revisions

– 소스파일등을수정하여커밋하게되면일정한규칙에의해숫자가증가

– 저장소에저장된각각의파일버전이라할수있음

– SVN의경우파일별로리비전이매겨지지않고변경발생단위로전체리비전이매겨짐

– 리비전을보고프로젝트진행상황을알수있음

 저장소를통해 본 리비전이해

전체 리비전 번호 증가

커밋의 단위

1
1
1
1

2

2
2

1
1
1
1

3

3
2
3
3

저장소의
파일 시스템

개별 소스들의
리비전

5.형상관리
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3. 소스 공유 (1/2)

 프로젝트공유

– 새로운프로젝트를저장소에추가

① Eclipse 패키지/네비게이션 뷰,
프로젝트 오른쪽 클릭 >
Team > Share Project...

② Share Project 마법사,
SVN 선택

③ Share Project 마법사,
저장소 위치 선택 > Finish

5.형상관리
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3. 소스 공유 (2/2)

 소스 단위 공유

– 공유중인프로젝트내에서해당소스를저장소에추가

① Eclipse 패키지/네비게이션 뷰,
대상 소스 오른쪽 클릭 >
Team > Add to Version Control...

② 팝업 창에서 내용 확인 > OK

5.형상관리
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4. Checkout

 초기 checkout

– 저장소에서전체소스의최종리비전을받아오는것

– 저장소인증정책에따라 ID, Password입력여부가결정

① Eclipse 메뉴,
Window > Open Perspective
> Other... >
SVN Repository Exploring

② SVN Repositories 뷰,
저장소를 확장하여 trunk 아래의
프로젝트 선택 > Check Out

③ 패키지/네비게이션 뷰에서
체크아웃한 프로젝트 소스 확인

5.형상관리
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5. Update

 저장소에소스 업데이트

– 체크아웃을한이후의타인에의한소스변경사항을확인

– 저장소에있는소스중로컬과비교하여변경된항목의최신버전의소스를가져옴

– 변경된항목의최신버전은로컬본에통합됨

Eclipse 패키지/네비게이션 뷰,
업데이트 대상 소스들/패키지/프로젝트에서 오른쪽 클릭 >
Team > Update

5.형상관리
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6. Commit

 Commit

– 로컬에체크아웃한소스를수정,파일추가,삭제등을한뒤저장소에저장하여갱신하는것

– 커밋을하면전체리비전이 1증가(CVS의경우수정한각각파일의리비전이증가)

① Eclipse 패키지/네비게이션 뷰,
커밋 대상 소스들/패키지/프로젝트에서 오른쪽 클릭 >
Team > Commit...

② 팝업 창에서 반영 내용 확인
및 Comment 입력

5.형상관리
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7. History 조회

 History

– SVN에의해관리되는특정소스와관련된과거모든리비전의내역

 History조회

– Eclipse의기본카테고리인 ‘Team’의 ‘History’뷰를통해조회할수있음

① Eclipse 패키지/네비게이션 뷰,
대상 소스 오른쪽 클릭 >
Team > Show History

② History 뷰에서
대상 소스의 History 목록과 리비전 상세 내역 조회

리비전 로그
목록

선택된 리비전의 Comment

선택된 리비전의
구조와 변경 파일들

5.형상관리
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8. 충돌 해결 (1/2)

 충돌(Conflict)

– 로컬에체크아웃이후수정한소스를저장소에커밋할때, 저장소의리비전이더높을경우충돌발생 (타인에

의해수정되고커밋된상태)

 충돌해결방안

– postpone:즉시반영없이,소스코드를계속수정.수정이완료된시점에다시시도

(충돌해결안함)

– diff:충돌된상황을비교.로컬과저장소의소스의차이를비교

– edit:로컬의파일을다시열어수정

– mine-full:저장소의리비전내용을무시하고,로컬의내용으로커밋.

– theirs-full:로컬의수정내역을무시하고,저장소의리비전으로대체하여업데이트

충돌 발생상황 예:
로컬 리비전 = 597 < 저장소 리비전 = 634

5.형상관리
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8. 충돌 해결 (2/2)

 충돌 해결 방안예

diff/edit:
로컬과 저장소의 소스를
모두 열어 비교/편집

theirs-full:
충돌이 발생한 파일에서 오른쪽 클릭 >
Override and Update... 선택

mine-full:
충돌이 발생한 파일에서 오른쪽 클릭 >
Override and Commit... 선택

5.형상관리



119
Page l 119



120
Page l 120

1. CI(Continuous Integration) 정의

여러명으로구성된팀이작업한것을자주-각팀원이하루에한번이상,매일여러번-통합하는것을가

리키는소프트웨어개발 Practice로,개발자,버전관리저장소,통합빌드머신등으로구성됨

6.CI 서버

Source Code Build

Feedback
Mechanism

Unit Tests

Test Coverage
Analysis

Build Success

Development
Server

CI ServerVersion Control Server
(SVN)

Build Failed

Code Inspection

Developer

Developer

Deploy

Code
Commit

Code
Commit

Watch & Polling

Notice
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2. CI(Continuous Integration) 효과와 특징

 효과

– 흔히발생하는일반적인위험을줄여준다.

– 에러를초기에발견할수있다.자주통합할수록에러가발생하는범위가좁아에러를잡는것이수월해진다.

– 잘동작하고에러가거의없는 S/W를유지할수있다.

– 언제어느때라도배포할수있는 S/W를생성해낸다.

– 반복적인수작업을줄여준다.

– 프로젝트가시성을좋게해준다.

– 개발팀이 S/W제품에대해보다큰자신감을갖게해준다.

 특징

－소스코드일관성유지 :소스관리시스템이필요하다.

－자동빌드 :빌드는 CI툴에의해자동으로이루어져야한다.

－자동테스트 :소스검증과함께기능/비기능테스팅을매번검증함으로써코드의품질을높일수있다.

－일일체크아웃과빌드 :빌드주기가길어질수록개발자소스의오류발생확률이높아지고그만큼시간을낭비

하게된다.

6.CI 서버
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3. Jenkins개요

Jenkins은오픈소스 CI서버로소스빌드스크립트를사용한자동빌드및빌드결과를개발자에게피

드백하는메커니즘을제공함

6.CI 서버

•초기화면:프로젝트리스트와빌드상태및빌드성공여부를보여줌
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4. Jenkins 특징 및 주요 기능

 Jenkins특징

– 쉬운 Installation : jenkins.war형태로 servlet container에배포

– 웹기반 UI를통한쉬운설정및즉각적인피드백

– 플러그인기반의확장성제공

– 깔끔하고잘정의된문서및 API

 Jenkins주요기능

– 소프트웨어자동빌드

• 빌드주기에따른일일빌드또는주간빌드기능제공

– 지속적이고자동화된빌드검증

• SCM폴링(polling)기능을통한최신코드기반의빌드수행

– 지속적이고자동화된빌드테스트

• 태스트슈트실행을통한코드품질검증

– 빌드후속절차자동화

• 컴파일된코드의패키징및테스트리포팅기능제공

6.CI 서버
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5. Jenkins 프로젝트 메뉴

Jenkins은등록된프로젝트의소스코드변경내용추적을위한메뉴와수동빌드메뉴그리고프로젝

트빌드상태를보여주는메뉴등을제공함

기본 메뉴

• 변경사항(Changes)
: 빌드 버전별로 SCM에서 지난 버전에 비해

서 변경된 내용에 대해 변경자와 커밋시에 개
발자가 추가한 comment를 확인할 수 있음

• 작업공간(Workspace)
: 프로젝트의 빌드 디렉터리로 브라우저를

통해 빌드에 사용된 파일 등을 확인할 수 있음

• Build Now
: 스케줄에 상관없이 지금 강제적으로 빌드

• Build History
: 빌드 수행 시기와 빌드 상태 및 성공 여부

를 보여줌

6.CI 서버
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Jenkins은 JUnit테스트의결과정보를목록으로보여주며,단위테스트결과및테스트소요시간등에

관한리포트기능을제공

6. Jenkins – JUnit 테스트 연동

JUnit 테스트 결과 JUnit 테스트 리포트

프로젝트의 단위 테스트 결과 및 테스트 소요 시간
등에 관한 리포트를 보여줌프로젝트 빌드에 따른 JUnit 테스트 빌드 결과를 보여줌

6.CI 서버
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